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Before You Begin / System requirements

Before You Begin
Read this section before you install, update, or upgrade beSOURCE Enterprise Edition.

System requirements
To install beSOURCE Enterprise Edition, make sure your server and client computer heave
the following minimum requirements:

l Server hardware
l Processor: 4~8 cores
l Memory: 8GB (16GB or more is recommended)
l Hard drive: 500GB or more

NOTE: Larger applications will require more RAM, hard drive space, and a more
powerful processor.

l Server software
l Operating system: Windows/Redhat or CentOS Linux - (recommendation: 64-bit
OS)

l JDK 1.7 or higher
l DBMS: Oracle 11g standard, MS SQL Server 2012 or higher, Maria DB 10.0 or
higher, MySQL 5.6 or higher

NOTE: DBMS is used for application analysis repository. One of the above DBs
can be selected. For better performance and stability, Oracle database is
recommended. Beyond Security does not provide a database license. It is your
responsibility to acquire a licensed database from the list above.

l Client PC hardware
l Processor: Dual core or higher
l Memory: 4GB
l Hard drive: 10GB or more

l Client PC software
l Windows 7 64-bit or Windows 10 64-bit
l .NET Framework 4.5 or higher

Enterprise Edition Installation Guide www.fortra.com page: 1



Before You Begin / System requirements

l Eclipse 3.4 or higher and JDK 1.6 or higher (if want to use Eclipse plugin)
l Operating system account (administrator is recommended)

NOTE: beSOURCE Enterprise edition supports both 32-bit and 64-bit operating
systems. The default JDK type (32- bit or 64-bit) is also determined based on
your operating system type.
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Installation Preparation / Database

Installation Preparation
Database
Install the database before installing beSOURCE Enterprise Edition. You can use one of
following databases:

l Oracle 11g standard or higher
l MS SQL Server 2012 or higher
l MariaDB 10.0 or higher
l MySQL 5.6 or higher

NOTE:
l To install Oracle or MS SQL Server, refer to official installation guide form each
vendor.

l To install MariaDB, refer to MariaDB installation information at
https://mariadb.com/kb/en/getting-installing-and-upgrading-mariadb/.

l To install MySQL, refer to MySQL installation information at
https://dev.mysql.com/doc/.

JDBC connection driver
While installing beSOURCE Enterprise edition, the installer needs JDBC driver to connect to
a database. Because of the unique distribution license policy of each vendor, you have to
follow their specific instructions.

Based on your database type, you can download the JDBC drivers as recommended below:

Database Download URL Recommended
file

Oracle 11g http://www.oracle.com/technetwork/database/enterpri
se-edition/jdbc-112010-090769.html

ojdbc6.jar
(Compatible with
JDK 1.7)

MS SQL
Server

https://docs.microsoft.com/en-
us/sql/connect/jdbc/microsoft-jdbc-driver-for-sql-
server

sqljdbc_
4.2.8112.100_enu
(Compatible with
JDK 1.7)
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Installation Preparation / JDK

Database Download URL Recommended
file

MariaDB https://downloads.mariadb.org/connector-java/ l mariaDB
Connector/J
1.1
(mariadb-
java-client-
1.1.9.jar)
(More
stable)

l mariaDB
Connector/J
1.7
(mariadb-
java-client-
1.7.1.jar)
(Compatible
with JDK
1.7)

MySQL https://dev.mysql.com/downloads/connector/j/ mysql-connector-
java-5.1.45
(Compatible with
JDK 1.7)

NOTE: Download a JDBC driver file and save it on which beSOURCE Enterprise edition
installer will be run. The installer will ask you to input the location of the JDBC driver file.

JDK
The beSOURCE server programs run in JDK environment, therefore JDK is required to be
installed first on the server computer. beSOURCE supports JDK versions 1.6 or later.

NOTE:
l JDK 1.7 or JDK 1.8 is recommended. If you want to use Web UI Client, JDK 1.8 is
required.

l It is strongly recommended that the JDK installation path doesn’t include blank
or space.

Preparation for Oracle tablespace
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Installation Preparation / Preparation for Oracle tablespace

In the case of using Oracle database as your repository, tablespace for beSOURCE server
must be created first and the size must be more than 2 GB. We recommend that you set the
tablespace’s ‘Auto Extend’ option value to ‘True’.

The beSOURCE server repository can be split into tablespace for general data and
tablespace for index. Each tablespace is divided into 2 categories by allowed extents size in
the point view of data operation. When installing, the user can select each tablespace.

Each tablespace should be created in the Oracle database before installing beSOURCE. The
separation of tablespace is simply suggestion against the large volumes of data. Note that
it is not a mandatory.

To create a tablespace, do the following:

1. In Windows, open Command Prompt.
2. Move to Oracle sqlplus tool directory (for example, CD

C:\oracle\product\11.2.0\dbhome_1\bin).
3. Access the Oracle DB with the appropriate privilege (for example,

C:\oracle\product\11.2.0\dbhome_1\bin> sqlplus “/as sysdba”).

4. Run the following SQL query to create a tablespace:
CREATE TABLESAPCE [BESOURCE_TABLESPACE_DATA] DATAFILE '[TS_
beSOURCE_DATA]' SIZE 2G AUTOEXTEND ON;

NOTE: [BESOURCE_TABLESPACE_DATA] refers to your tablespace name and
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Installation Preparation / Preparation for Oracle tablespace

[TS_beSOURCE_DATA] refers to your data file name.

User account
Create a user account for Oracle before you install beSOURCE. The database administrator
will need to create the user account and grant it DBA privileges. Otherwise, following
privileges should be granted to the account.

l Resource privilege
l Connect privilege
l Create Any View privilege

NOTE: Few Oracle versions prevent the default tablespace capacity from being used
fully. In such case, the tablespace should be set as 'unlimited' for its usage.

To create a user account, do the following:

1. In Windows, open Command Prompt..
2. Move to Oracle sqlplus tool directory (for example, CD

C:\oracle\product\11.2.0\dbhome_1\bin).
3. Access the Oracle DB with the appropriate privilege (for example,

C:\oracle\product\11.2.0\dbhome_1\bin> sqlplus “/as sysdba”).
4. Run the following SQL command to create a user:

CREATE USER [BESOURCE_DB_USER] IDENTIFIED BY [BESOURCE_DB_PWD]
DEFAULT TABLESPACE [BESOURCE _TABLESPACE];
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Installation Preparation / Preparation for MS SQL Server database

NOTE: [BESOURCE_DB_USER] refers to your database user name for beSOURCE
and [BESOURCE_DB_PWD] refers to your database user password.

5. Run the following SQL command to grant a privilege to the new created user:
GRANT RESOURCE, CONNECT, CREATE ANY VIEW TO [BESOURCE_DB_USER];

Preparation for MS SQL Server database
We recommend that you create a database in MS SQL Server with command line window or
GUI tool. It will be used for beSOURCE server repository.

To create the database with command line window, do the following:

1. Run your command line window and Access to the MS SQL Server with appropriate
privilege. e x) C:\Users\gtone> osql -U sa

2. Enter your password of sa user.
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Installation Preparation / Preparation for MS SQL Server database

3. Run the following SQL command to create a database:
CREATE DATABASE [BESOURCE_DB] GO

NOTE: [BESOURCE_DB] refers to your database name.

User account
Create a user account for MS SQL Server before you install beSOURCE. The database
administrator will need to create the user account and grant it DBA privileges. Otherwise,
following privileges should be granted to the account.

Otherwise, the following privileges should be granted to the account:

l db_datawriter Role
l db_datareader Role
l db_ddladmin Role

To create a user account, do the following:

1. Run your command line window and Access to the MS SQL Server with appropriate
privilege. e x) C:\Users\gtone> osql -U sa

2. Enter your password of sa user.
3. Enter the following SQL command to create a user:
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Installation Preparation / Preparation for MariaDB database

EXEC sp_addlogin '[BESOURCE_DB_USER]','[BESOURCE_DB_PWD]','
[BESOURCE_DB]'
GO
USE [BESOURCE_DB]
GO

NOTE: [BESOURCE_DB_
USER]    means    your    database    username    for    beSOURCE and
[BESOURCE_DB_PWD] means your database user password.

4. Enter the following SQL command to grant a privilage to the newly created database:
EXEC sp_adduser '[BESOURCE_DB_USER]','db_datawriter, db_
datareader, db_ddladmin' GO

Preparation for MariaDB database
We recommend that you create a database in MariaDB with command line window or GUI
tool. It will be used for beSOURCE server repository.

To create the database with command line window, do the following:

1. Run your command line window and move to MariaDB’s bin directory.ex) CD
C:\Program Files\MariaDB 10.2\bin

2. Access the MariaDB with appropriate privilege. ex) C:\Program Files\MariaDB
10.2\bin>mysql –u root –p

3. Enter your root user password.
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Installation Preparation / Preparation for MariaDB database

4. Enter the following SQL command to create a database:
CREATE DATABASE [BESOURCE_DB]
CHARACTER SET = 'UTF8'
COLLATE = 'utf8_bin';

NOTE: [BESOURCE_DB] refers to your database name.

User account
Create a user account for MariaDB before you install beSOURCE. The database
administrator will need to create the user account and grant it DBManager Role privileges.

To create a user account, do the following:
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1. In Windows, open Command Prompt.
2. Move to MariaDB’s bin directory (for example, CD C:\Program Files\MariaDB

10.2\bin)
3. Access the MariaDB with the appropriate privilege (for example, C:\Program

Files\MariaDB 10.2\bin>mysql –u root –p)
4. Enter your root user password.
5. Enter the following SQL command to create a user:

CREATE USER ‘[BESOURCE_DB_USER]’@’%’ IDENTIFIED BY ‘[BESOURCE_
DB_PWD]’;

NOTE: [BESOURCE_DB_USER] refers to your database user
name for beSOURCE and [BESOURCE_DB_PWD] refers to your database user
password.

6. Enter the following SQL command to grant privileges to the newly created database:
GRANT ALL PRIVILEGES ON [BESOURCE_DB].* TO '[BESOURCE_DB_
USER]'@'%' IDENTIFIED BY '[BESOURCE_DB_PWD]';
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7. Enter the following SQL command to apply the privileges:
FLUSH PRIVILEGES;

NOTE: You can also use MariaDB’s GUI tool, HeidiSQL to execute the above SQL
statements.

You can see the new database in the GUI tool after completing the above SQL statements.

Enterprise Edition Installation Guide www.fortra.com page: 12



Installation Preparation / Preparation for MySQL database

NOTE:While installing beSOURCE Enterprise edition, you could encounter bad
performance of MariaDB due to its default log setting. You can avoid this issue by
setting ‘innodb_flush_log_at_trx_commit’ options value to zero temporary.

C:\MaraiDB 10.1\bin>mysql – u root – p[passwrod]MariaDB [(none)]> set global innodb_
flush_log_at_trx_commit=0; MariaDB [(none)]> show variables like 'innodb_flush_log_at_
trx_commit';

If you have performance issues while operating the beSOURCE server with MariaDB, you
may consider setting the ‘innodb_flush_log_at_trx_commit’option value to 0
permanently in MariaDB’s configuration file. The configuration file is my.cnf or my.ini.
For the detail information, refer to MariaDB’s manual.

Preparation for MySQL database
We recommend that you create a database in MySQL with command line window or GUI
tool. It will be used for beSOURCE server repository.

To create the database with command line window, do the following:

1. In Windows, open Command Prompt.
2. Move to MySQL’s bin directory (for example, CD C:\Program

Files\MySQL\MySQL Server 5.7\bin).
3. Access to the MySQL with appropriate privilege (for example, C:\Program

Files\MySQL\MySQL Server 5.7\bin> mysql -u root -p).
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Installation Preparation / Preparation for MySQL database

4. Enter your password of root user.

5. Enter the following SQL command to create a database:
CREATE DATABASE [BESOURCE_DB]
CHARACTER SET = 'UTF8'
COLLATE = 'utf8_bin';

NOTE: [BESOURCE_DB] refers to your database name.

User account
Create a user account for MySQL before you install beSOURCE. The database administrator
will need to create the user account and grant it DBManager Role privileges.

To create a user account, do the following:
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Installation Preparation / Preparation for MySQL database

1. In Windows, open Command Prompt.
2. Move to MySQL’s bin directory (for example, CD C:\Program

Files\MySQL\MySQL Server 5.7\bin).
3. Access to the MySQL with appropriate privilege (for example, C:\Program

Files\MySQL\MySQL Server 5.7\bin >mysql –u root –p).
4. Enter the root user password.
5. Enter the following SQL command to create a user:

CREATE USER '[BESOURCE_DB_USER]'@'%' IDENTIFIED BY ' [BESOURCE_
DB_PWD]';

NOTE: [BESOURCE_DB_USER] refers to your database user name for beSOURCE
and [BESOURCE_DB_PWD] refers to your database user password.

6. Enter the following SQL command to grant a privilege to the new created database:
GRANT ALL PRIVILEGES ON '[BESOURCE_DB]'.* TO '[BESOURCE_DB_
USER]'@'%' IDENTIFIED BY '[BESOURCE_DB_PWD]';
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Installation Preparation / System

7. Enter the following SQL command to apply the privilege:
FLUSH PRIVILEGES;

System
Note the below requirements for the server computer system:

l Disk space: at least 3 GB of disk space (more space would be required depending on
the analysis size).

l System user account for beSOURCE server: user account which has installation
privilege (Admin privilege is recommended).
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Installing the beSOURCE Server /

Installing the beSOURCE Server
You can install the beSOURCE Enterprise Edition’s server using an installer. The installer
name is besource_v5.0_Enterprise_Edition.exe.

You can copy the installer program to hard disk or insert installation CD to your CD-ROM
drive. Follow the steps below.

1. Copy the besource_v5.0_Enterprise_Edition.exe installer file to your
computer or insert your installation CD.

2. Run the installer file.

NOTE: If a JVM loading error with JDK 1.8 appears while running the installer, try
the LAX_VM option in command-line window:
C:\>besource_v5.0_Enterprise_Edition.exe LAX_VM [java_
home/bin/java.exe]
Change [java_home/bin/java.exe] to fit your environment. The JDK path
cannot contain blank or space.

3. On the Welcome page of the installer, select English.
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Installing the beSOURCE Server /

4. Select OK.
5. On the Introduction page, select Next.

6. On the License Agreement page, read over the license agreement and if you agree to
the terms, select I accept the terms of the License Agreement.
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Installing the beSOURCE Server /

7. Select Next.
8. On the Choose Install Program page, select the sub-components ofbeSOURCE

Enterprise Edition you want to install (this guide selects all sub-components in this
step).

9. Select Next.
10. On the Choose Java Virtual Machine page, select a Java Virtual Machine or JDK for

beSOURCE server.
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11. Select Next.
12. On the Choose Install Folder page, use the default install location or select Choose

to select your own.

13. Select Next.
14. On the Select Repository page, select a database for repository. This guide uses

MariaDB. To use another database type, refer to the Appendix on page 46.
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Installing the beSOURCE Server /

15. Select Next.
16. On the JDBC Driver page, select the location of JDBC driver file for your repository

database connection. Select a different JDBC file based on your database type.

17. Select Next.
18. On the Repository Settings page, enter your database connection information in the

URL, User ID, and Password boxes. You must change the IP address and database
name in the URL box, corresponding to your MariaDB installation.
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Installing the beSOURCE Server /

19. Select Next. The installer will now test the database connection. If a connection error
message appears, recheck your URL, User ID, and Password values.

20. On the Configure Analyzer page, set the options for the Analysis Server (a Java
application that is responsible for source file analysis). It is recommended to use the
default values for the following:

l Server Name - The name of the Analysis Server (do not include spaces).
l Listen Port - The port number of the Analysis Server.
l Server Encoding - The encoder to use with the Analysis Server.
l License File (Optional) - Select your license file for the Analysis Server. To
apply your license after installation, see Applying Your License on page 26.
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Installing the beSOURCE Server /

21. Select Next.
22. On the Configure View Server page, set the options for the View Server (a Java web

application based on Tomcat that is responsible for administration). It is
recommended to use the default values for the following (except IP Address):

l IP Address - The IP address of your server computer.
l Listen Port - The port number of the Tomcat web application server.
l Shutdown Port - The shutdown port number of Tomcat web application server.
l Server Encoding - The encoder for the View Server.
l Analyzer Server IP Address - The IP address of the computer hosting the
Analysis Server (typically your server computer).

l Analyzer Server Port - The listening port of Analysis Server. If you did not
change the default value for Listen Port on the Configure Analyzer page, you
do not need to change this value.

23. Select Next.
24. On the Choose Shortcut Folder page, select In a new Program Group and enter

beSOURCE.
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25. Select Next.
26. On the Pre-Installation Summary page, review installation information from the

previous steps. Select Previous to make any necessary modifications to your
settings.

27. Select Install.
28. Once the installation process is complete, select Done.
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Applying Your License
If your license file (license.xml) was not applied during the installation process, you can do
it manually.

To manually apply your license file for the Analysis Server, do the following:

1. Rename your license file to license.xml (if it is currently named something else).
2. Copy the license file to $beSOURCE_HOME\analyzer\license directory (replace

the $beSOURCE_HOME portion of the path with your current installation location).
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Starting and Stopping the
beSOURCE Server
There are two types of beSOURCE servers; Analysis Server and View Server. Both are based
on J2EE technology and can run on Linux and Windows-based environments. This section
will explain how to start and stop the server in Windows.

beSOURCE uses the following environment variables:

l CM_HOME - Directory of where beSOURCE is installed (for example, C:/beSOURCE).
l CE_HOME - Directory of where the beSOURCE Analysis Server is installed (for
example, C:/beSOURCE/analyzer/server/CE).

l VW_SERVER - Directory of where the beSOURCE View Server is installed (for
example, C:/beSOURCE/WAS).

NOTE: It is recommended to start and verify the Analysis Server before launching the
View Server.

Starting the beSOURCE Analysis Server
To start the beSOURCE Analysis Server in Windows, do one of the following:

l From the Windows start menu, select beSOURCE > Start {Name} Server.
l Alternatively, you can open Command Prompt, go to the CE_HOME directory, and then
execute the startServer.cmd file. Verify in the command window that Analysis
Server has been successfully executed.
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Starting and Stopping the beSOURCE Server / Starting the beSOURCE View Server

Starting the beSOURCE View Server
To start the beSOURCE View Server in Windows, do one of the following:

l From the Windows start menu, select beSOURCE > Start View Server.
l Alternatively, you can open Command Prompt, go to the VW_SERVER/bin directory,
and then execute the startup.bat file. Verify the Analysis Server has been
successfully executed.

Stopping the beSOURCE Analysis Server
To stop beSOURCE Analysis Server in Windows, do one of the following:

l From the Windows start menu, select beSOURCE > Stop {Server Name}.
l Alternatively, you can open Command Prompt, go to the CE_HOME directory, and then
execute the stopServer.cmd file (you can also press CTRL+C in the command
window). Verify the Analysis Server has been successfully executed.

Stopping the beSOURCE View Server
To stop beSOURCE View Server in Windows, do one of the following:

l From the Windows start menu, select beSOURCE > Stop View Server.
l Alternatively, you can open Command Prompt, go to the VW_SERVER/bin directory,
and then execute the shutdown.bat file (you can also press CTRL+C in the
command window). Verify the Analysis Server has been successfully executed.

Enterprise Edition Installation Guide www.fortra.com page: 28



Installing Client Programs / Installing and launching the beSOURCE Admin Console with a web browser

Installing Client Programs
There are five types of beSOURCE client programs:

l beSOURCE Admin Console
l beSOURCE View Client
l beSOURCE Developer
l beSOURCE Eclipse, IntelliJ, Android Studio Plugin
l beSOURCE Jenkins Plugin

beSOURCE Admin Console is an administration tool used to conduct various management
tasks. It adopts Microsoft .NET Framework as a technical basis for ensuring user
convenience and a rich user interface. The administrator can access the server with this
tool anytime and anywhere using internet connection.

All commands or operations in beSOURCE Admin Console are delivered to the beSOURCE
View Server and required server-side jobs are executed on the server.

beSOURCE (View) Client is used to view and utilize the results of source code vulnerabilities
inspection on the beSOURCE server. It adopts Microsoft .NET Framework as a technical
basis for ensuring user convenience and rich user interface. Users can access the server
with this tool anytime and anywhere using internet connection.

beSOURCE Developer is for developers to inspect local code while connected to the
beSOURCE Server. Developers can analyze their own source files on the computer.

beSOURCE Eclipse Plugin is for developer to inspect local code while connected to the
beSOURCE Server. Developers can analyze their own source files in the Eclipse IDE.

beSOURCE IntelliJ and Android Studio plugins are for developers to inspect local code while
connected to the beSOURCE Server. Developers can analyze their own source files in the
IntelliJ or Android Studio IDE.

beSOURCE Jenkins Plugin allows users to integrate the beSOURCE Server with Jenkins.
Users can request source code inspection on the beSOURCE Server from Jenkins.

Installing and launching the beSOURCE Admin Console
with a web browser
You can install and launch the beSOURCE Admin Console using a web browser.
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Installing Client Programs / Installing and launching the beSOURCE Admin Console with a web browser

To install beSOURCE Admin Console, do the following:

1. Verify the Analysis Server and View Server are running.
2. Open your web browser and go to http://beSOURCE_View_IP:View_Port

[Default:50102] (for example, http://localhost:50102)

NOTE: beSOURCE_View_IP is the IP address of server computer where the View
Server is installed and View_Port is the port number assigned during installation.

3. In the User ID box, enter your user ID.
4. In the Password box, enter your password.
5. Select Login.

NOTE:
l The default User ID and Password to login to beSOURCE Admin Console
are besource and besource. When you deploy beSOURCE in a production
environment, you should update the password.

l Only users who have proper rights given to them by administrator can
access the beSOURCE Admin Console. After five incorrect password
entries, you will be blocked and your user account disabled.

l Install Microsoft .NET framework 4.5 or later before installing beSOURCE
Admin Console.

6. When you log in, move your pointer over each icon view a short description.
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Installing Client Programs / Launching the beSOURCE Admin Console

7. If you attempt to download one of beSOURCE client programs and a startup program
does not automatically download, select Setup Download to download the setup.exe
file.

8. Install the setup.exe file.
9. Select the beSOURCE Admin Console icon. It will start downloading and run

automatically.

NOTE: Execute the beSOURCE Admin Console through a web browser to automatically
check for and download any available updates.

Launching the beSOURCE Admin Console
After you download the beSOURCE Admin Console with a web browser, you can launch it
using the desktop shortcut icon.

To launch beSOURCE Admin Console using the desktop shortcut icon, do the following:

1. Double-click the beSOURCE Management shortcut icon.
2. In the Server box, select a registered server. To register a server, see Adding or

changing the server connection setting of beSOURCE Admin Console on page 32.
3. In the User ID box, enter your user ID.
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4. In the Password box, enter your password.
5. Select Login.

Adding or changing the server connection setting of
beSOURCE Admin Console
To add or change the beSOURCE Server connection setting, do the following:

1. On the beSOURCE login window, select Config. The Connect Config dialog opens.
2. Select Add.
3. Enter the Server name, IP Address, and the Port number of your beSOURCE View

Server.
4. Select Save or Save & Close.
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NOTE: You can also change server connection setting values in the Connect
Config dialog.

Installing the beSOURCE View Client
1. Open your web browser and go to http://beSOURCE_View_IP:View_Port

[Default:50102] (for example, http://localhost:50102).
2. Log in using your user ID and password.
3. Select the beSOURCE View Client icon.

4. Select the beSOURCE View Client icon. It will start downloading and run
automatically.

Launching the beSOURCE (View) Client
After you download the beSOURCE (View) Client using a web browser, you can launch it the
.

The way to launch it and configure server connection setting is exactly same as the Admin
Console. You can refer to the Admin Console section.
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Installing beSOURCE Developer
To install and launch beSOURCE Developer, follow below instructions:

1. Log in to server with a web browser as explained in the above section.
2. Select the third icon to download the beSOURCE Developer.

3. On the first access, beSOURCE Developer program is downloaded and installed
automatically from server.

Launching beSOURCE Developer
After you download the beSOURCE Developer with a web browser, you can launch it using
the desktop shortcut icon.

To launch the beSOURCE Developer using the desktop shortcut icon, do the following:

1. Double-click the beSOURCE Developer shortcut icon on your desktop.
2. Select File > Login.
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3. In the Server box, select a registered server. To register a server, see Adding or
changing the server connection setting of beSOURCE Admin Console on page 32.

4. In the User ID box, enter your user ID.
5. In the Password box, enter your password.
6. Select Login.

NOTE: You must log in to use beSOURCE Developer. Your license information is stored
on the server and is applied when you sign in. To check your license, select Tools >
Options… > License Settings.

Installing the beSOURCE IDE plugin
To use the beSOURCE Eclipse plugin, the following requirements must be met:

l Install Eclipse 3.4.0 or later before installing the plugin.
l Java 1.6 or later.
l To analyze C source files in the Eclipse, install the Eclipse IDE for C/C++ Developers
or Eclipse C/C++ Development plugins first.

NOTE: For more installation information, see Reference - Installing the Eclipse IDE for
C/C++ Developers or Eclipse C/C++ Development plugins on page 38.

Installing beSOURCE Eclipse plugin
To install the plugin, do the following:

1. Select Help > Install New Software.
2. On the Available Software dialog, select Add.
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3. On the Add Repository dialog, enter the following:
a. Name - beSOURCE
b. Location - Enter the beSOURCE server’s Eclipse plugin deployment address. For

example, http://192.168.0.1:50102/eclipse where 192.168.0.1 is the IP
address of the beSOURCE View Server and 50102 is its port number.

4. Select OK.
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5. On the Available Software dialog, select the following:
a. In the Work with box, select beSOURCE.
b. Expand the beSOURCE category, and then select 'beSOURCE'.
c. Optionally, select beSOURCE - C language pack (Optional) to run a C language

analysis.

6. Select Next.
7. Check your settings in Install dialog.
8. Select Next.
9. If you agree to the EULA terms, select I accept.

10. Select Finish.
11. On the Security Warning dialog, select Stop.
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12. When prompted, select Yes to restart Eclipse.
13. beSOURCE will now appear in the Eclipse main menu.

Reference - Installing the Eclipse IDE for C/C++
Developers or Eclipse C/C++ Development plugins

1. Download Eclipse IDE for C/C++ Developers at
https://www.eclipse.org/downloads/.

2. Install Eclipse IDE for C/C++ Developers.
3. Open Eclipse IDE for C/C++ Developers.
4. On the Available Software tab, select Help > Software Updates.
5. You will find installation sites registered by the Eclipse version. Access and install C

and C++ Development for the following sites (if you are using Eclipse 3.5 or Eclipse
3.6, select Eclipse C/C++ Development Tools under Programming Languages):

a. Eclipse 3.4 - Ganymede Update Site
b. Eclipse 3.5 - 'Galileo - http://download.eclipse.org/releases/galileo
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c. Eclipse 3.6 - 'Helios - http://download.eclipse.org/releases/helios

Installing the beSOURCE IntelliJ/Android Studio plugin
beSOURCE IntelliJ/Android Studio plugin’s supported environment:

l Android Studio 1.0 or later
l IntelliJ IDEA 12 or later

NOTE:
l Android Studio or IntelliJ IDEA’s runtime environment must be Java 1.7 or later.
l The encoding value of each source file must be same as a project’s encoding
value.

l beSOURCE server’s locale and the plugin’s locale must be same.

To install the plugin, do the following:

1. Select File > Settings.
2. Select Plugins.
3. On the Plugins window, select Browse repositories.
4. Select Manage repositories.
5. On the Custom Plugin Repositories window, select the + button.
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6. On the Custom Plugin Repositories dialog, enter the URL of the plugin repository
(http://[Server IP address]:
[Port]/plugins/intellij/updatePlugins.xml).

7. Select OK.
8. Select the URL you just added.
9. Select the beSOURCE plugin, and then select Install.
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10. After the installing the plugin, restart the IDE.
11. You can reselect the beSOURCE plugin to view the currently installed version or to

remove it.

Installing the beSOURCE Jenkins plugin
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The Jenkins plugin allows users to request source code inspection on the beSOURCE server
from Jenkins (continuous integration (CI) tool).

Prerequisites
The following requirements must be met to install and use the beSOURCE Jenkins plugin:

l Jenkins 1.625.3 or later
l A web browser that supports Jenkins or Hudson

Downloading the beSOURCE Jenkins plugin
To download the beSOURCE Jenkins plugin, do the following:

1. Open your web browser and go to http://beSOURCE_View_IP:View_Port
[Default:50102] (for example, http://localhost:50102).

2. Log in using your user ID and password.
3. Select the icon farthest to the right.

4. In your web browser, go to http://YourServer_
IP:YourServerPort/plugins/jenkins/beSOURCE.hpi

5. The beSOURCE.hpi plugin file will download to your computer.

Installing beSOURCE Jenkins plugin
To install the beSOURCE Jenkins plugin, do the following:
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1. Log in to the Jenkins server.
2. Select Manage Jenkins.

3. On the Manage Jenkins page, select Manage Plugins.

4. Select the Advanced tab.

5. Select Browse to locate and select the beSOURCE.hpi file, and then select Upload.
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6. On the Installing Plugins/Upgrades page, select Restart Jenkins when installation is
complete and no jobs are running.

7. After the beSOURCE Plugin finishes installing, you can select the Installed tab to
manage it.
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After You Are Done
Congratulations! beSOURCE Enterprise Edition is now installed. Read the following for
additional information and your next steps.

Contacting us
For additional resources, or to contact Technical Support, visit the Beyond Security Portal at
https://beyondsecurity.freshdesk.com/support/home
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Appendix
This section describes the installer setting by database type.

Setting for Oracle
1. Select a JDBC driver file location for your repository database connection.

2. Select Next.
3. Enter your connection information for the database such as JDBC URL, user ID, and

password.

NOTE: You must change the IP address (127.0.0.1), port (1521) and database
name (ORCL) in the URL to correspond with your Oracle installation.
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4. Select Next. The installer will now test the database connection. If you get
connection error message, please check your setting values.

Setting for MS SQL Server
1. Select a JDBC driver file location for your repository database connection.

2. Select Next.
3. Enter your connection information for the database such as JDBC URL, database

name, user ID and password.
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NOTE: You must change the IP address, Port and database name in the URL,
corresponding to your MS SQL Server installation.

4. Select Next. The installer will now test the database connection. If you get
connection error message, please check your setting values.

Setting for MySQL
1. Select a JDBC driver file location for your repository database connection.

2. Select Next.
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3. Enter your connection information for the database such as JDBC URL, database
name, user ID and password.

NOTE: You must change the IP address and database name in the URL,
corresponding to your MySQL installation.

4. Select Next. The installer will test the database connection. If you get connection
error message, please check your setting values.

Git and JDK Version issue
If you installed beSOURCE Server with Java 1.7 and run it on the Java version, importing
source files from Git or Git Hub will fail due to security policies of Git. A workaround for this
issue is setting the internal Sub-Process-Option of Analysis Server.

To set the internal Sub-Process-Option for Analysis Server, do the following

1. Open the beSOURCE Admin Console
2. Log in with your credentials.
3. Select System > Server Setting.
4. On the Analysis Server tab, expand Job.
5. In the Value box for Sub-Process-Option, enter the following value: -

Dhttps.protocols=TLSv1.1,TLSv1.2.
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6. Select Confirm.

NOTE: You do not have to restart your server after applying this change.
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